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Introduction (Checking your plans)

In this introduction to writing non-fiction, we make some assumptions. Primarily we 
assume you have read the book How to plan your non-fiction book available on Step 1 – 
Plan on this site, and that you have understood and used the PANIC sequence outlined there 
– our handy non-fiction writing mnemonic that stands for the stages of preparation;

Prepare

Arrange

Narrow

Investigate

Commence

If that is the case then you already know what type of non-fiction book you are wishing to write and who your 
intended audience will be. You will have constructed a detailed plan and have done most of the core research that you 
need to use within the book. 

You will have broken your book down into chapters and you know what is to be in each.

Finally, you will have read plenty of material similar to the type of book you are intending to write so that you have a 
feel for the style of writing that will fit the market at which you are aiming. (You will have thought about or worked 
out what makes your book special or different to others of the same genre and what its selling points are.)

If you haven’t done these things, then we suggest you take the time to read that book on planning now, and complete 
those stages, so you are at the start line for your non-fiction book.

About writing in general terms (selecting your timber)

The first thing to know about writing is that so long as you have the ability to put words together, such as writing a 
good and interesting email to a friend, then you have the potential to write a book. Perhaps the biggest impediment to 
good writing is that people tend to overcomplicate it, to try to sound like someone they’re not, rather than just letting 
the words flow as they would if they were writing to a friend. 

Flow
The first ‘secret’ to good writing is to write first and worry about editing later. Just let the words flow. While that may 
be a little simplistic, we don’t want you to write like someone once told you you should – we encourage you to ‘find 
your own voice’. 

Find the way you would naturally express things when you are not trying to create a piece of written work that 
conforms to someone else’s expectations, restraints, forms and formats, controls, guidelines or traditions. Finding your 
own voice almost certainly means just letting the words come and writing ‘without thinking’. While there may be forms 
of non-fiction that require a certain conformity to external parameters – a scientific field guide for instance – there is 
room nonetheless for an author’s voice to make the book special.

Keep a notepad or some recording device beside you as you write so that you can note down material that you will 
need to go back and check, add to or alter at a later date. This way you don’t lose the immediate flow of your writing 
and the sound of your own voice. Writing in a simple, genuine tone so that the reader feels as if you are speaking to 
them in the most natural way is, in most instances, ideal. Such writing makes the reader feel comfortable, at ease, and 
means they don’t have to work at their reading. When information is presented in such a manner, learning what is 
required from a non-fiction work is made a great deal easier for the reader. 
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Quantity versus quality
The second secret of good non-fiction writing is that in any comparison between quantity and quality, quality wins over 
quantity every time. Those of us who have been formally educated have often been set our writing tasks by word count e.g., 
a 3,000-word essay on the socio-political impact of the Julian calendar. So we’ve often learnt to waffle on to fill the space. 

When writing a book, we have to unlearn this behaviour and it can be quite difficult to shake. So the new rule is; just 
write what needs to be said. You’ll know, depending on who you are addressing as your audience, just how much 
embellishment is expected. If you are writing for an academic purpose, your prose may be pitched at a higher level, 
with deeper argument, more searching analysis and teasing out of fine points of meaning, than if you are writing a 
family memoir – but taking into account your audience, the point remains sound; quality beats quantity every time.

Audience
So think about your audience, and with an appropriate economy of words, tell all that a friend from the target 
audience might want to know – AND NO MORE! You can always add a little more description or explanation later if 
your early reviewers find there is information missing. Your job as a writer is to make your audience feel that every 
word is there for good reason. If your review readers from your actual target audience confirm that they find none of it 
boring to read, then you have done your job as a writer.

Collaboration
At times, a non-fiction work is a collaboration between a number of individuals. This approach is often employed 
for the writing of local histories for example. There are a few tips that are worth knowing if you are involved in a 
collaborative work. As we outlined in the PANIC process in How to plan your non-fiction book, effective planning will 
include laying down comprehensive guidelines. What can happen otherwise is that the input from various contributors 
can become very unbalanced and difficult to edit into a single whole that stands up under the critical eye of the reader. 
We have seen collections of anecdotes where one writer has written almost bullet-point notes, statements of the facts 
only, of about a page in length, while another contributor has told their tale in over 40 pages with all the emotional 
content, descriptions, side issues and minutiae included. Be aware that, right from the start, good planning and 
direction to contributors, including a writing plan, can save a lot of problems later.

Some handy tools
The second point worth noting in terms of any sort of collaboration, is that Microsoft Word has a couple of very 
useful but little-known features that make version control through the retention of a clear original manuscript very 
easy. The first is called Track Changes, found under the Tools menu. Under Track Changes you can send a person the 
manuscript, they make their alterations and additions under Track Changes and send it back to you. What you receive 
is their changes all marked in colour, with anything they deleted out to the side in a box. You can then use Accept and 
Reject Changes to accept or reject each in turn. It can take a little time to learn how to use it really effectively but it is 
a worthwhile tool and very useful when you send your finished manuscript to readers as part of the editing process. 
They can mark up their suggested changes straight in your manuscript and you can then accept or reject them. This is 
especially useful if there are more than just a few minor changes to a manuscript; then there is no time wasted because 
it can be emailed straight back to you. Time is also saved by not having to retype changes from your paper copy. You 
don’t even have the worry that the copy may get lost in the mail!

The second tool is called Compare and Merge Documents and is also found on the Tools menu. Imagine you decide 
to send copies of your manuscript to several people, let’s say six, and have them each send back their Track Changes 
alterations. You might accept the changes they each made, but now you have six manuscripts in addition to your 
original and each one containing differences. How do you easily reunite them into a single manuscript? Using 
Compare and Merge Documents, you can bring each of the six up one at a time alongside your original one and have 
the computer show you the differences in the two. By accepting and rejecting as you wish, you can bring in all the 
changes. Again, a little experience in its use will make it seem like the simplest of tools. It can also be used, of course, 
if one of your six fails to use track changes in the first place, and makes their edits straight in the document. This is no 
longer the problem it might at first appear if you know about Compare and Merge Documents.
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Pacing yourself
While we are still in the preparatory stages prior to writing (selecting our timber), it may be timely to offer some advice 
to help you achieve your goal. Firstly, writing a book can be a long and at times laborious process. It may be the 
longest sustained commitment to a single complex task that many people achieve in their entire lifetime, and that, in 
itself, is often part of the charm and attraction many people feel for the notion of being a published author. 

There will, however, be times where the flesh is willing but the spirit is weak – where you find it hard to get motivated 
to get going and make another day’s contribution to the overall task. This is the time to tell yourself that every great 
journey is accomplished by many small steps, taken one at a time. All you have to do that day is take one more small 
step. As Aristotle is reputed to have said when someone asked him how to reach Mount Olympus, “Just make sure 
that each step you take is in that direction.” 

Criticism
One of the surest ways to lose motivation is to subject yourself to unhelpful criticism. Be careful who you let read your 
work in the early stages to protect yourself from this. There is plenty of time later for criticism at a time when you 
can more usefully use it (or dismiss it) and will indeed be seeking it to ensure you have written well for your target 
audience. 

If someone insists on reading your work early and you don’t feel you can refuse them, just gently explain to them that, 
as you are just free-forming your writing at this stage, they are looking at nothing more than the priming coat, to use 
a painting analogy. The subsequent reworks will add the gloss and any criticism at this point should either be withheld 
for fear of demotivating the painter, or expressed at least in terms that this is a very early draft that will be overlaid and 
reworked later to a more glossy finish. Few, if any, writers get it right in one go, and most work and rework early drafts 
to achieve the finish they seek.

It’s not a straight path
If you do lose motivation to write at any point, just remember that a well-planned book does not even have to be 
written in the order you have planned. Think about it. Films are not filmed in chronological order. As long as your 
planning is thorough enough, you shouldn’t need to write chronologically through the sequence. If you are stuck on 
the part you are currently writing, or a bit tired with the information you are working on, why not take a break by 
going to another part of the book where there is a body of information that you feel ready to write about immediately, 
and write that today. 

It is still one more step along the way, and it keeps the writing flow going. By avoiding getting frustrated by one section 
of the book that is holding you up, you feel instead the success of seeing the words flow onto paper, a few hundred a 
day until, before you know it, you have a few thousand, then a few tens of thousands, and a book is produced. 

Sequencing tools
A simple sequencing tool if you are writing in non-chronological order and are choosing not to use the computer to 
write and order your output, is to keep the writing you have done in a simple ring binder which can be divided into 
chapters and sections as you wish. These can be added as you produce them, until the entire first draft is completed. 

You can produce the same effect on computer by writing each part as a separate file. Just name each file carefully by 
chapter and section number and ensure that on your book plan you tick off each section as it is completed. If you put 
all of your files in a folder, they should occur in sequence if you have numbered them correctly (remember to use 01, 
02 for single digit numbers). Once you reach the end of your writing, or when you have completed each chapter, you 
can rejoin each individual file back into a single document, either by cutting and pasting them manually one at a time, 
or, by naming each as a subdocument and using the master document function found under Outline on the View 
menu to bring them all together.
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Helping the writing process
A couple of important housekeeping matters. Again, don’t stray far from a notepad or recording device as mentioned 
in How to plan your non-fiction book. Sparks of inspiration or things that need to be remembered will strike you at 
all sorts of odd times and you should jot them down as soon as they occur, as they will often not stay around if not 
captured immediately. 

Your brain operates at two levels, your conscious brain processes in the conscious realm, but after you lose conscious 
focus on an idea or a problem area in your writing, your subconscious mind (sometimes also called your super-
conscious mind) works like a super computer, processing the material and checking it against all sorts of stored 
memories from your past in such a manner that you are frequently unaware of it happening. 

When suddenly the computation stops and out to your conscious mind pops a solution, you need to be ready to 
capture it.  Just notice it happening and capture these ideas as they come. If you work with real intent to let your 
subconscious mind help you, you can even spend a bit of time at the end of each day’s writing, reading your planning 
concerning the area that you will cover in tomorrow’s writing, then consciously consign it to your subconscious and 
let it do its job. The next day, when you sit down to write you will find that a lot of material is more easily available 
than if you had just read those notes and were starting out to write straight from your conscious mind’s processes. 
Try it. 

Backing up
Think very carefully about backing up your work, whether you are using a computer or not. Ideally, keep a second 
copy at all times and keep it at a different place. With a computer this may involve a process as simple as emailing 
a copy of your work to date to yourself at a hotmail address each day. That way, if your computer corrupts and you 
lose everything on your hard drive, you should still be able to access the latest file from any other computer. Equally, 
depending on the age of the machine, it might involve burning to CD or copying to a portable data storage device 
(memory stick/flash drive/USB stick). In fact with the portability of data through such devices today, you could feasibly 
work at various times of a day on several different machines, carrying your latest data backup with you on your 
portable device and leaving your second backup on whichever machine you last used. This would suit someone who 
works on a computer and can use their lunch hour for a bit of additional writing. 

For those who don’t use a computer for writing it is important to find a way to back up work. You may photocopy 
your new notes each day after writing and take them offsite, or you could even fax them directly to a trusted external 
receiving point where they can be stored safely. There is nothing as demoralising as losing a large amount of your hard 
work, and nothing you write to replace it will sound as right in your head as the piece you lost did.

Writing in more specific terms (preparing and sharpening your tools)

Now let’s think about the construction of a piece of non-fiction writing. 

Beginning, middle and end
Essentially, for most non-fiction there is a beginning, a middle and an end, but within the work there may, and almost 
certainly will be, other beginnings, middles and ends. In fact each paragraph, each section and each chapter also has its 
own beginning, middle and end – rather like Russian nesting dolls. 

Whenever you are sitting down to write, whether it is a paragraph, a section or a chapter you are considering, think in 
these terms. 

Paragraphs
Each paragraph, for example, should generally be related to a single idea. As such, the paragraph should introduce 
that idea, expand it, then in some way close it, which may be to lead into the next paragraph in which a different point 
will be added. These beginnings, middles and ends need not be contained in separate sentences, nor even be separate 
words, but you should ideally be able to see that the thought contained is complete.
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For example, the following paragraph, from a book on starting a business, is on the main topic GIVING YOUR 
CUSTOMERS MORE THAN THEY EXPECT. You can see that the first sentence – the beginning, explains what is to be 
discussed in this paragraph. The next four amplify and explain this idea, giving examples of what it means to give 
customers more than they expect. The last sentence closes this idea by raising a proviso – that products and services 
must be of a good price and quality – and giving the benefits of such action; a satisfactory ending.

A simple rule of thumb that is more important when you are starting out than at any other time, is, ‘ALWAYS 
GIVE YOUR CUSTOMERS MORE THAN THEY EXPECT’. Remember that the interpersonal side of business is 
central and its importance to your business success never wanes. Serve your customers well in a friendly and 
polite manner. Go out of your way to find the situations when you can provide at least a little more than is 
expected and add a distinctive little extra; a clean and tidy waiting/restroom, that bit better communication, 
a thank you card, a bunch of flowers. Providing that your quality is comparable and competitively priced, 
customers will usually reward you with their continued business and invaluable word-of-mouth promotion to 
others.

You can see that the paragraph is a complete thought with a beginning, middle and end, though it may at times be 
quite tricky to define where one part stops and the next commences. In this instance, the full stops are reasonable 
markers of the transition points between each.

Audience
Whenever you are writing non-fiction, you must keep in mind to whom the book is speaking and ensure the 
appropriate tone is adopted in the writing to appeal to that target audience. There is no point in writing in heavy 
academic terms if the projected audience is the popular crime-exposé reader. Equally, you should not adopt too light 
and familiar a tone if you are seeking to capture the real interest of the serious history reader. Try at all times to keep a 
typical projected reader in mind so that you retain the correct tone for the work.

Types of writing
When writing all those beginnings, middles and ends, there are effectively three types of writing that can be used. 
They are description, narration and dialogue, and in most non-fiction the writer’s art is to try to get a pleasing balance 
between each, though of course dialogue is much less likely to occur in some forms of non-fiction. A potted definition 
of each for our purposes might be:

•	 Description – a verbal depiction of something or someone.

•	 Narration – the act of explaining information or ideas or giving an account.

•	 Speech – the actual words characters utter, as reported or written as anecdotes.

Some simple rules of thumb with regard to each are;

Description
Be very careful of excessive use of adjectives. Be aware of the point of view you are writing from when describing 
something. A great deal of descriptive information can often be cleverly woven into the narrative to make it less 
obviously a lengthy description, thereby relieving the reader of having to endure a heavy descriptive passage. While 
there are times for extended descriptive passages, there are also means to eradicate them, so make the judgement – 
how will your audience prefer to receive the information that needs to be described? 

Having said that, however, where you are using description, make sure that your text is alive with a richness that 
captures and retains the reader’s interest.

Narration
The general rule here, as with description, is to recognise that lengthy narrations can be somewhat boring, so they are 
best relieved by the use of interesting language, variety, tight wording (quality not quantity), diagrams and illustrations 
where appropriate, and examples such as personal anecdotes to illustrate a point. Where possible, show the reader, 
don’t tell them. Keep the amount of narrative to a minimum and let the personal stories and anecdotes, descriptions 
and illustrations achieve a smoother read while still conveying the information effectively. 
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Dialogue/speech
In non-fiction, you need to decide how you will edit reported speech in order to make the information readable. Speech 
does not flow the same way as the written word, and if you have recorded interviews for example, you may find at 
times that it is quite difficult to transcribe straight into print in a meaningful way. In most cases, you should try to make 
it sound as much like the actual speech as you can while recognising that the written word won’t, in most cases, be 
exactly the same as speech. Speech has very few full stops and has frequently incomplete grammar, amongst other 
faults, whereas written speech has to be sufficiently grammatical and well punctuated to be discernable to the reader. 

“I just come round the corner and seen the place burning and I heard this woman screaming 
and I thought…I thought well you know I wonder if there’s anyone helping her and she just 
went on screaming and that and I thought hell if I don’t go and see if I can help she might die 
and you know I’ll be sitting there thinking that I didn’t do nothing.. just let her die.”

Depending on the nature of your book, you might choose either of the following methods for presenting such a piece. 
For a less formal work, where the thrust of what was said was more important than the exact wording;

“I just came round the corner and saw the place burning. I heard a woman screaming and I 
thought…  I wonder if there’s anyone helping her. She just went on screaming and I thought, 
Hell if I don’t go and see if I can help she might die and I’ll be sitting there thinking that I didn’t 
do anything… just let her die.”

For a more formal work, where accuracy is important and any word changed must be marked, you can use several devices;

•	 Brackets for words changed or added for better comprehension

•	 Dotted lines for words left out

•	 (sic) to indicate correct presentation of an incorrect spelling

“I just c(a)me round the corner and seen (sic) the place burning and I heard this woman 
screaming and I thought… I wonder if there’s anyone helping her…She just went on 
screaming… and I thought, Hell if I don’t go and see if I can help she might die and… I’ll be 
sitting there thinking that I didn’t do nothing (sic)… just let her die.”

Often, reported speech in non-fiction is shown as text in a different font, possibly italicised. A lot of italicised text is 
hard to read so save the italics for only short passages of speech and/or use a different indent setting. At times, a 
different justification e.g., justified left only instead of fully justified, can be used.

Anecdotes
It has been shown time and again, that one of the most effective means of making a non-fiction book more readable 
is to include plenty of stories within the text. These lighten up the reading and can be used very effectively to illustrate 
points, or in fact to tell part of a story (as in a diary entry by a character from the past, used to describe an aspect of 
how that piece of history impacted on someone present at the time). It is quite acceptable to differentiate anecdotes 
and stories from the general text of the non-fiction work in various ways. This is often achieved visually as noted above.

Tackling your book (constructing your manuscript)

Now it is time to break down your chapter plot planning; firstly into scenes and then into paragraphs. You can happily 
do this a chapter at a time, just before you write – doing so gives you a chance to interplay the ideas from your plot in 
your mind once again before actually writing. If you have done all the preparation work following the PANIC outline in 
How to plan a non-fiction book then you will have the majority of planning your structure already done, requiring only 
some fine tuning; so this bit will be easier to do.

Sections
In non-fiction, as in fiction, we usually signify sections within a chapter by leaving a larger space between paragraphs. 
Your sections should be largely self-defining. Section breaks usually occur where there is a significant change of topic 
or focus within the overall topic of the book, but not so significant as to make it another chapter.  
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What to call a chapter – what to call a section?
In a book, for example, on New Zealand’s top fifty companies of all time, you may define your chapters based on 
districts from which those businesses arose, and your section breaks within introduce each new business to be 
discussed. Alternatively, you may make each your chapter based on periods at which the top fifty businesses were 
started (eg: 1840–1860, 1860–1880, 1880–1900 etc) and use the section breaks within each chapter to mark the 
different businesses that were started within that era. 

You may even choose to make the book fifty chapters long and to discuss each business one at a time (perhaps ranked 
by length of time in existence or, better still, overall impact on the development of the New Zealand economy), with 
section breaks marking where you start to discuss each new era of each company’s development. 

As you can see there are no hard and fast rules, it is simply one way of structuring your content to gain the best 
presentation – and you don’t have to have any sections at all. 

But, as you can also see, there is a great deal of potential to make a book containing the same basic core of 
information more, or less, interesting depending on the way in which you present it. In our assessment as publishers, 
the approach of ranking these companies in order of importance to the economy would be the most easily marketed 
approach as it creates another dynamic than just the – possibly dry – history of the companies themselves. It also gives 
you room for an extra paragraph or two for each company, to explain how you came to rank them in that particular 
place on your ranking scale, in that their impact on the economy may not be reflected by turnovers alone – for 
example, the company that invented refrigerated shipping.

Final plan
Once you have defined your paragraphs and sections, write a few short sentences to define the key points that need to 
be covered in each section. In effect become the brief descriptors for your paragraphs. Once you have written the key 
sentences, check the following before commencing writing:

1.	 Beginning, middle and end – are the paragraphs you have planned going to provide a strong opening to the 
section that will hook readers to continue to read, with an effective and economic middle and a strong ending?

2.	 Description, narration, dialogue, illustration, anecdote etc – for each paragraph, plan the approach by which 
the information can best be conveyed in an interesting and informative manner appropriate to the type of work 
you are writing.

3.	 Signposting – is there any information that should be referred to in this section by way of foreshadowing a later, 
perhaps deeper analysis? If so, where and how?

Illustrations
When considering the use of illustrations in a non-fiction book there are a few pointers you should know. Microsoft 
Word has a considerable capability for drawing, that allows you to create most diagrammatic representations 
reasonably simply, straight in your document. Go to the Insert menu, then choose Pictures then Autoshapes and 
have a play. You’ll be surprised what is available. If you choose Wordart you can create all sorts of text effects; with 
Organization Chart you can create relationship trees and with Chart you can create graphs right within your document.

If you require drawings in a document, black-line drawings can easily be scanned and added. Be careful using pencil 
though. You may draw in pencil first then use tracing paper and a black drawing pen available from any artshop to 
render a good black image. If you have simple line drawings and the lines look too wobbly, most layout people should 
be able to make them look machine-perfect by rendering them through software that smoothes the lines and balances 
the line thicknesses. Tools such as Streamline do this.

If you are going to use photographs in your document decide whether these are to be placed in a single section or 
spread throughout the book. Choose photographs with good definition if you are printing in black and white. If you 
have older, ‘muddy’ photographs or newer ones of a generally dark nature (such as a photograph of a forest) you will 
need to discuss the possibility of having these lightened in the print process. All photographs will need to be supplied 
at a high resolution (at least 300dpi) in a JPEG or TIF format.
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Talk to your client manager about the layout of your photographs. Digital printing means that colour photos can be 
placed anywhere within your book, but to keep costs down, try to minimise the spread of colour photographs.

Captions
To add captions to your pictures and diagrams as you add them to the book, go to the Insert menu on Microsoft Word 
then choose Reference then Captions. This way, the caption will always stay with the picture, even if the picture has to 
move to the next page due to lack of space. Once your caption is there, you can still edit and customise it.

Index
While we are talking about some of the tools of Microsoft Word that are helpful to the non-fiction writer, we need to 
mention tools that will help you easily create an index, assuming your book is of the type that needs one. Indexes are 
important in histories and research/ reference books of most kinds including recipe books, but not so necessary in the 
likes of self-help, how-to, well-being, personal experience genres and the like. As a rule, if in doubt, put one in, even if 
only a brief one.

The task of creating an index used to be an exacting and arduous one, but today, with the assistance of your computer 
tools, it can be achieved much more simply.

As you write, keep a note of terms, headings and subheadings that you feel ought to be included in an index of the 
book. Normally these include the names of key people, places, things (e.g., a certain type of warship, plane or vehicle) 
and events (e.g., Battle of the Somme, Napier earthquake, sinking of the Wahine). We suggest you open a second 
document (call it your index document) that sits on your task bar as you write. As you write about anything that should 
be included in the index, add the reference word to the index document. Then you can refer back to this when you 
start to create your index in your manuscript.

Once the book is complete and properly edited so that you are sure you won’t have to make any more changes, take 
each word on your indexing list in turn and in your manuscript document, using the Find facility under the Edit menu, 
mark each as an index entry. You can choose a range of options here, from marking each word to marking an entire 
passage. 

Once you have marked all your chosen words as index entries, form your index by going to the Insert menu and 
choosing Reference then Index and Tables and choosing the way you would like your index to be formed. Your 
computer will automatically form your index, and change the page numbers to correct ones even if you change the 
book to different dimensions.

This is not a full explanation, as indexing is a very complex topic – professional indexers make a science of it – and this is 
not a book on indexing. Suffice it to say, it is better to have a less than perfect index in a book that should have an index, 
than to have none, so if you are writing a book that needs one, use your Help menu if you require further explanation.

Table of contents, footnotes and endnotes
There are tools available on Microsoft Word to manage each of these functions too, in much the same way as we have 
just described for indexing, such that your table of contents automatically places the correct page number on which 
each chapter starts, keeps footnotes on the same page as the reference that required a footnote (ideal for historical 
and scientific works) and ties appendices and other endnotes back to the correct page reference no matter how the 
book is laid out during finalisation.

Let the words flow
Now you are ready to write and should find that the words can pour forth quite freely. Just let them flow onto the 
paper without worrying too much about reworking sentences or paragraphs to make them conform to the plan. Just 
get it down. Once you have written all the paragraphs of a section or chapter you can come back and rework each 
with reference to your planning, making sure that the flow is not damaged by your reworking. You should find that 
your story goes together smoothly and easily using this approach.
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Immediate follow-up
After you have written each day’s work, read it aloud. By voicing it you are far more likely to hear and see errors that 
you may miss if you just scan the work in silence. 

A week or so later
Leave your work for at least a week after that and then read it once more, looking not just for spelling errors but also 
for such grammatical and structural faults as repetitiveness, poor sequencing, inadequate explanations or arguments, 
style changes, paragraphs or ideas that seem to be out of order or that could be better arranged, contradictions and so 
forth.

Groom it to an extent that it sounds totally natural and free of awkwardness then leave the more major edit to the 
end. You will learn more about how to go about that in the next book.

Completion
Your book is now ready to move into the deeper editing, proofreading and then layout and design stages. Valuable 
resources in regard to these critical areas are also available as free downloads on the PublishMe website.


